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1. Creating your library

Add PDFs to Mendeley

You can add PDFs to Mendeley by clicking
the Add Document button on the far left of
the toolbar. Alternatively, you can drag and
drop PDFs into the content pane. Mendeley
will then attempt to detect the document |..
details (bibliographic data). |

Any documents whose details Mendeley is Drag & drop PDFs here to
uncertain about will be added to the Needs add them to your library.
Review section for manual verification. You ‘

may use Mendeley's Document details i

lookup (CrossRef, PubMed, and ArXiv) or |~

Google Scholar Search to complete missing
document details (see below).

Import/export EndNote™, BibTeX and RIS libraries

Switching from other reference management software such as EndNote™ to Mendeley is simple. As
EndNote™ uses their own proprietary file extension (.enl) you will need to export your library as .xml
file (the more open common standard) in order to migrate to Mendeley:

In EndNote™:
1. Select File == Export
2. Choose “XML” type and “RIS” as output style
3. Give your library a name and save it on your PC

Then in Mendeley:

1. Select File == Add Files
2. Choose the XML file that you have previously exported from EndNote™ and click on “Open”
3. Your EndNote™ library will appear in Mendeley Desktop
To import BibTeX and RIS XML alongside PDFs choose:
File ==» Add Files
Likewise your data can easily be exported from Mendeley:

1. Select the documents you would like to export and go to File ==»Export or press
Ctrl + E or Cmd + E on MacOS.

2. You will then be given the option to save your files in the most common formats - .xml, .ris,
and BibTeX files.



Document details lookup (CrossRef, PubMed, and ArXiv)

You can also lookup document details from CrossRef (DOI), [ pewis | notes |
PubMed (PMID), and ArXiv. Just fill in the document ID in the | Creation ofa Bacterial Cell

respective field and click the magnifying glass icon next to it to
get the details for those documents. These fields are located in

the Details tab.

Google Scholar Search

Journal:  Soience

Year: 2010
Volume: 52
Issue:

Pages:
Abstract:
Tags:
Keywords:
URL:

Catalog IDs

ArXiv ID:

DOL: 10.1126/science, 1190719
PMID:

You can lookup document details with Google Scholar in Mendeley:

1. Inputthe correct document title

2. Click search

Mendeley will try to complete the missing data from Google Scholar. (Note: The lookup works only
for imported PDF files and not for manually added entries.)

Details Notes

= on Google Scholar,

Details are Correct| |Search by Title

@ These details need reviewing. You can mark them as correct, or search by tite

Journal:
Year:
Volume:
Issue:

Pages:

Abstract:

Tags:

Keywords:

URL:

A view research catalog entry for this paper

Type: []numal Artide P— i ]
\_Creation of a Bacy , \
At 1

[ Detais | notes |

Controlled by a Chemically Synthes...
Authors: D, Gibson, 1. Glass, C. Lartigue et al.

#A| View research catalog entry for this paper

1 http:/fwww,sdencemag. org/fogifdoif 10, 1126 fscienc. ..

|

@ These detals need reviewing, You can mark ty , or search by title
2 on Google Scholar.
Details are Correct| |Search by Title| &

Type: Journal Artice

=

Creation of a bacterial cell controlled by a
chemically synthesized genome

authors: D, Gibson, J. Glass, C. Lartigue et al.
A3 view research catalog entry for this paper

Journal:  Science
Year: 2010
Volume: 323
Issue: 5987
Pages: 52

Abstract:
Tags:
Keywords:

URL:

(1" http:/ fwww. sciencemag. org/egifcontentfabstract/sci; 32/5987/52

-



One-click Web Importer

You can import references with a single click from the services listed below. To install the Web
Importer and to find out how to use it, just select:

Tools==» Install Web Importer...

M MEI’IdEIE}" Deskto
File Edit View Help

% E Invite Colleagues... b z
b
Add Dl Install Wek Importer... ove  Sync

D s D . der  Lib

oeHmEr o Install M5 Word Plugin o HhE

My Library ) All Documents
= All Documents Optiens...
(T e ® [ Authors

+ Recently Added

e ACM Portal e Google BookSearch e PLoS

e ACS Publications e Google Scholar e PNAS

e AIP Scitation e TACR ePrints e PubMed

e Amazon e IEEE Xplore e RePEc

e APS e Informaworld e SAGE

e APA PsycNET e IngentaConnect e ScienceDirect
e arXiv e INIST/CNRSI e ScienceMag

e BioMedCentral e Institute of Physics e Scirus

e BioOne e ISI Web of Knowledge e Spires

e C(CiteseerX e JSTOR e SpringerLink
e CiteULike e Lancet Journals e SSRN

e Copac e MyOpenArchive e Wikipedia

e DBLP e NASA ADS e Wiley InterScience
e EBSCO e Nature e WorldCat

e GBV e OpticsInfoBase e Zetoc

... and growing.


http://portal.acm.org/portal.cfm#_blank
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http://www.worldcat.org/#_blank
http://zetoc.mimas.ac.uk/

Watch folders to automatically add PDFs to Mendeley Desktop

When you place a document in a watched folder, it will gy
be automatically added to Mendeley so you can S T

Add Files... Ctrl+0 ~
annotate, cite, and browse its references instantly. Ad Foder.. cutsrifes0 | ‘;?
Adding files to Mendeley using watched folders makes it | sy vimon. —
easier to add multiple papers in one go and keep them Expot.. cul-E k © B Author

o = TheMendeley s

Delete Documents

where you want on your computer. Femre o Colltion
Rename Document Files...
Synchronize Library F5

Quit Ctrl+Q

Synchronize PDFs with your Mendeley Web account

(] Mendeley Deskio e

File Edit View Tools Help

%.‘3 ‘ﬂo‘i%z (a-

Add Delete Remove from Create Remove  Sync

Documents Documents glegtion Folder  Folder  Library

My Library =1 All Documents Hide Settings 2
= All Documents

= Recently Added
Favorites

‘" -

¥, My Publications Synchronize attached files

Unsorted
C::::E Folder... This synchronizes PDFs (and other attached files) with your

Mendeley account
Groups () For my entire library
Creats Group. . @ For selected collections
Trash

)
iii Al Deleted Documents O] 2 My Publications

Synchrenization opticns

Web Space usage

(4 0 MB / 500 MB Personal Web Space

For more Web Space, restricted groups and members, please upgrade your account.

Save & sync| |Cancel

Filter by Authors
All
The Mendeley Support Team

If you want to have access to your PDFs from anywhere, activate the file synchronization
feature. By enabling this feature you are able to access your PDF files in your Mendeley Web
library.

1. Make sure that “All Documents” in the “My Library” pane is selected
2. Select “Edit Settings”

3. Adjust the settings to your needs.

4. Synchronize your library

5. Login to your Mendeley Web account and see the result in your library



2. Managing your documents and references

Merge duplicate author names, tags, or publications

In the filter by authors/tags/publications pane, click a name you recognize has been
duplicated or is incorrect, and drag & drop it onto the correct one to rename it.

Filter by My Tags =

A

Rename all instances of How to™ to "how-to™?

[ Do not ask again

QK ] [ Cancel

E.g. if you have two documents tagged “How to” and “how-to”, dragging the latter one onto

the former will rename the incorrect entry.

Documents can be marked read/unread

File Edit View Tools Help

B .R m wme 2

Add Delete Remove from Create Remove  Sync
Documents Documents  Collection Folder  Folder  Library
My Library =] All Documents

Edit Settings
=

=] All Documents
_‘— Recently Added E Authors
1. Favorites

® My Publications

[ ]
. ‘ . Z The Mendeley Support Team
|| Unsorted
.

Create Folder... /-

Groups
Create Group...

Favorites

Mendelestktop
File Edit View Tools Help

B R w e 2

Add Delete Remove from Create Remove Sync

Documents Documents  Collection Folder  Folder  Library

My Library f All Documents Edit Settings
=1 Al Documents
_l— Recently Added 1 ® [ Authors
7. Favorites ‘ = The Mendeley Support Team
2 My Publications / =
|| Unsorted %

Create Folder / /

Groups
Create Group...

Keep track of your unread papers. When
you add documents to Mendeley, they are
marked unread by a small green dot. If you
open them within the Mendeley PDF viewer
they will be marked read. Or simply click on
the green dot to toggle read/unread.

You can mark your favorite documents (or
documents you keep want to track of) with
the star icon. Simply click to star, and click
again to un-star. All favorite documents will
appear in the Favorites Folder, so you can
refer back to them with one click.



Search as you type

Smart search in documents highlights the search term as you type, so you can find what
you're looking for quickly. Just type into the search bar and watch Mendeley find matching

terms in the document.

FEile  Edit

¥ SAREBNYCLQ] o 2

Highlight Add Select  Copy Paste Rotate Rotate Zoom Zoom Fullscreen  Sync
Text Notz  Text Left  Right Out In Library

View Go Jools Help

ly Library Creation of a bacterial .. [

»
ARCH AR

Creation of a Bacterial Cell Controlled
by a Chemically Synthesized Genome

Daniel G. Gibson,* John 1. Glass,® Carole Lartigue,* Vladimir N. Noskov, Ray-Yuan Chuang,®
Mikkel A. Algire, Gwynedd A. Benders,® Michael G. Montague,® Li Ma,* Monzia M. Moodie,*
Chuck Merryman,® Sanjay Vashee,® Radha Krishnakumar,® Nacyra Assad-Garcia,*

Cynthia Andrews-Pfannkoch,” Evgeniya A. Denisova,® Lei Young, Zhi-Qing Qi,*

Thomas H. Segall-Shapiro,? Christopher H. Calvey,* Prashanth P. Parmar,! Clyde A. Hutchison 1112
Hamilton 0. Smith,” ]. Craig Venter**

We report the design, synthesis, and assembly of the 1.08—mega—base pair Mycoplasma mycoides
JCVI-syn1.0 genome starting from digitized genome sequence information and its transplantation
into a M. capricolum recipient cell to create new M. mycoides cells that are controlled only by the
synthetic chromosome. The only DNA in the cells is the designed synthetic DNA sequence,
including “watermark” sequences and other designed gene deletions and palymorphisms, and
mutations acquired during the building process. The new cells have expected phenotypic properties
and are capable of continuous self-replication.

the complete genetic sequence of phage
©X174 (1), the first DNA genome to be
completely sequenced. Eighteen years later, in
1995, our team was able to read the first complete
genetic sequence of a self-replicating bacterium,
Haemophilus influenzae (2). Reading the genetic

In 1977, Sanger and colleagues determined

We developed a strategy for assembling viral-
sized pieces to produce large DNA molecules that
enabled us to assemble a synthetic M. genitalium
genome in four stages from chemically synthe-
sized DNA cassettes averaging about 6 kb in size,
This was accomplished through a combination of
in vitro enzymatic methods and in vivo recombi-

==

(a- myco

crude M. mycoides or M. capricolum extracts, or
by simply disrupting the recipient cell’s restriction
system (3).

‘We now have combined all of our previously
established procedures and report the synthesis,
assembly, cloning, and successful transplantation
of the 1.08-Mbp M. mycoides JCVI-synl.0
genome, to create a new cell controlled by this
synthetic genome.

Synthetic genome design. Design of the M.
mycoides JCVI-synl.0 genome was based on the
highly accurate finished genome sequences of two
laboratory strains of M. mycoides subspecies capri
GMI2 (8, 9, /]). One was the genome donor used
by Lartigue ef al. [GenBank accession CP001621]
(10)). The other was a strain created by trans-
plantation of a genome that had been cloned and
engineered in yeast, YCpMmycl.l-Anpelilres
[GenBank accession CPO01668] (&). This project
was critically dependent on the accuracy of these
sequences. Although we believe that both fin-
ished M. mycoides genome sequences are reli-
able, there are 95 sites at which they differ. We
began to design the synthetic genome before both
sequences were finished. Consequently, most of
the cassettes were designed and synthesized based
on the CP001621 sequence (/7). When it was
finished, we chose the sequence of the genome
successfully transplanted from yeast (CPO01668)
as our design reference (except that we kept the

|
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Annotate PDFs

You can add highlights and notes to documents
within Mendeley Desktop.

1. Open a PDF in Mendeley's PDF viewer by
double clicking on it in the central pane,

2. Add highlights and notes by clicking on the
Highlight Text or Add Note buttons on the
menu.

h,” Sanjay Vashee,” Radha Krishnakumar,™ Nacyra Assad-Gardia,”
s-Pfannkoch,” Evgeniya A. Denisova,” Lei Young,* Zhi-Qing Qi,*
|-Shapiro,” Chri H. Calvey," Prashanth P. Parmar,” Clyde A. Hutchison |
ith, ). Craig Venter:3*

=

sign, synthesis, and = x Mycoplasma mycoi
bme starting from ¢ Yo" and its transplantatf
[um recipient cell t 0¥/10/2010 18:16:46 controlled only by
some. The only DN You can add highlights and notes to DNA sequence,
mark” sequences aj Jociments within Mendeley Desitop. solymorphisms, and
ed during the build | phenotypic propert
of continuous self-

lger and colleagues
k genetic sequenct
the first DNA ger
enced. Eighteen ye...
fas able to read the first complete
of a self-replicating bacterium,

gy for assembling vi

rge DNA molecules

synthetic M. genitali
& = wemgee sfom chemically synt]
sized DNA cassettes averaging about 6 kb in si
This was accomplished through a combinatior

You can share these annotations with your co-workers. To do so

1. Open a PDF that is part of a Group (see below),

2. Make your annotations,



3. Sync these annotations to Mendeley Web by going back to “My Library” and clicking on
“Sync Library”.

Note: These annotations are not stored in the actual PDF-file, but rather in your Mendeley
account. To create a new PDF file that contains all annotations, you can export the PDF with
all its annotations by choosing: File — Export with Annotations from within the Mendeley
PDF viewer.

Multiple level undo in document details

You can undo recent changes to your document details or annotations by clicking Undo in
the usual place. Select the following option in the drop down menu:

Edit ==»Undo

or Ctrl+Z (Cmd+Z for Mac)

Tag and edit multiple documents at once

When you want to tag or add details for more than one document in one go:

1. Select the documents you want = x
to edit at once by pressing Ctrl +
left clicking the documents you (a-
Want to SeIeCt Edit Settings Details | Motes | A
Added Edits will affect all selected documents.
2. Notice the batch editing =ms 73m T e (g
confirmation message - e .
tion
3. Input your data —
The data can be tags, notes, or other "™ “*" Pages
document details such as the Abstract
publication name. Tags (3)
| bacteria; genome| \
E.g., in this example the entered tags Author Supplied Keywords
will be applied to all selected
Ci
documents. v




File Organizer

Mendeley's file organizer can automatically rename your PDFs and file them in a clear folder
structure, making it easier to find your files outside of Mendeley. You can find it here:

Tools ==» Options File ==»Organizer tab

or for Mac choose: Mendeley==> Preferences ==» File Organizer tab

In the tab, select:;

1. Organize my files: to make a £ Options ]
copy of all documents added
to Mendeley within one folder

2. Sort files into subfolders: to
create a folder structure
based on selected document
details

3. Rename document files: to
rename the often non-
descriptive names of your
PDFs to file names that are
more meaningful, including
the author, journal, year, and
title

General | DocumentDetails | File Organizer | Watched Folders | Bibtex | Zotero /Citellke | Connection |

Organize my fies

Copy fles to: | C:\Jsers\Jser\DocumentsiMendeley Desktop

Sort files into subfolders

Unused fields:

Year Title ‘

Drag bubbles down to add or up to remove.

Folder path: | (Author | Journal ‘

Example:  Ci\JsersWUser\Documents endeley Desktop}Author\Journaly

7| Rename document files

Unused fields:

Drag bubbles down to add or up te remove. Hyphen-separated -

File name: ‘ Author Year Title ‘

Example:  Author - Year - Title.pdf

ok | [ concel ][ ey |

Once you have your documents in Mendeley, you can cite and reference them within Word
and OpenOffice Writer with ease.



3. Citing references

Installing the Word and OpenOffice Writer plug-in

The Mendeley Word & OpenOffice plug-ins integrate Mendeley into your word processor. To
install the Mendeley plug-in, simply click on the Tools menu within Mendeley Desktop and

select the option for the word processor you wish to use.

Using the Word and OpenOffice Writer plug-in

Once installed you will have toolbar buttons that will allow you to cite a document, generate a

bibliography, or manually edit any entry.

1. When you are creating a paper and you want to cite a document from your Mendeley

Library just click on Insert Citation in the Mendeley toolbar:

# » Insert Citation | Merge Citations [ Insert Bibliography |American Psych ~ | £ Refresh Export -

: Custom Toolbars

|-1-|-§-|-1-|-2-|-2-|-4-|-

R - - P I R L
' ' ' ' ' '

Thistext needs a quotation

IJA

Ay = —
—f’f Home Insert Page Layout References Mailings Review View Developer Add-Ins

IR R

2. If you are using Word on Windows, a box will appear allowing you to search for
references by author, title or year (note that this is only available for Microsoft Word for

Windows at the moment; for Word on Mac or OpenOffice, see step 5).

This text needs a citation.

fatigue damage

Damage Based Fatigue Criterion For Solders in Electronic Packaging

Shengmin Wen - 2004 - ITHERM

Fatigue damage modeling in solder interconnects using a cohesive zone approach

A Abdul-Bagi; PIG Schreurs; MGD Geers - 2005 - International Journal of Solids and Structures
Damage evolution governed by microcrack nucleation with application to the fatigue of
635n-37Pb solder

V Stolkarts; LM Keer; ME Fine - 1999 - Journal of the Mechanics and Physics of Solids
Experimental damage mechanics of microelectronic solder joints under fatigue loading
C Basaran; H Tang; S Mie - 2004 - Mechanics of Materials

4

My Library {can't collaborate)

- l lm GoTo Mendeley] l oK Cancel

e —

3. When you find the reference that you want to cite, just click OK and you’re done. Note
that you can cite multiple references, by using semicolons to separate them.
4. If you prefer to find references using Mendeley Desktop, press the “Go to Mendeley”

button beneath the search box, which brings up Mendeley Desktop.

10



5.

Then select the document in Mendeley Desktop, and click Send Citation to MS Word
(or OpenOffice Writer, respectively). Again, you can also cite multiple documents. Just
hold the Ctrl key and left click the documents you want to cite.

ﬂ Mendeley Desktop

N
Eile Edit View Tools Help 5
B .RBR W ® & 2 |7 x
Add Delete Remove from  Create Remove  Sync Send Citation o
Documents Documents Collection Folder  Folder  Library to MS Word e
My Library =~ | =l All Documents Edit Settings
=1 All Documents o & = -
L) Recently Added = w Authors Tltle
- VUL UL WIS SO LN Y T a3 au L TR
Favorites .
© Needs Review o Stam, F A; Davitt, E Effects of thermomechanical cyding on lead-free (SnPl
A My Publications and SnAgCu) surface mount solder joints
Unsorted -~ Stolkarts, V; Keer, L M; Fin_.. Damage evolution governed by microcrack nudeation |
Create Folder... application to the fatigue of 635n-37Pb solder

Whichever way you go, your citation will be sent to your word processor:

a

Egn\ H ) - H Documentl - Microsoft Ward

Home Insert Page Layout References Mailings Review View Developer Add-Ins

 » Insert Citation Merge Citations []Insert Bibliography American Psych ~ &b Refresh Export -

Custom Toolbars

Thetext needsacitation{Abdul-Baqi, Schreurs, & Geers, 2005).

You can select your preferred citation style in the drop down menu in your word processor.

You can now generate a bibliography by clicking “Insert Bibliography”:

r

E?m\ [ I - Documentl - Microsoft Word

i
Home Insert Page Layout References Mailings Review View Developer Add-Ins

“ » Insert Citation Merge Citations [ Insert Bibliography American Psych = & Refresh Export ~

Custom Toolbars

The text needs acitation(Abdul-Bagj, Schreurs, & Geers, 2005).

Bibliography

Abdul-Bagj, A., Schreurs, P.1.G., & Geers, M. G. D. (2005). Fatigue damage madeling in solder
interconnects using a cohesive zone approach. International fournal of Solids and Structures,
42,927-942.
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A warning for OpenOffice users:

OpenOffice users, DO NOT use File > Save As to save in .doc format. This will remove all
Mendeley field data. Instead use the “Export MS Word Compatible” button.

Please ensure you have "Tools - Options > Load/Save - General - Always save as" set
to ODF.

Cite in Google documents (and other editors)

You can also add citations in other text editors, such as Google Docs. Just select the paper
you want to cite in Mendeley Desktop and click:

Edit==» Copy Citation

Then Paste it into the document you are composing. Alternatively, you can drag & drop the
paper from the Mendeley Desktop window to the document, and a reference in the current
selected citation style will be added there.

Cite using BibTeX

You can also cite and create
bibliographies in LaTeX documents.
Mendeley Desktop creates a
BibTeX file for your entire library, for
each group or per document. The
BibTeX file(s) are updated each
time you make a change to your
personal library in  Mendeley
Desktop.

The citation keys are automatically
generated in the format
[AuthorYear]. You may edit citation
keys manually by enabling the

15 Optiens

|

General | Doqument Detals File Grganaer Wiatched Folders Bibtex Zotero [ CitelLie Cennecton
Bbtex Expart Preferences

/| Escape Latex special characters {#(} %& etc}

Bbtex Syndng
Bibkex gyneng kesps one or seversl Bibtey files up to date with the documents in your lbrary.
+| Enable Biotex synang
@ Create one Bibtex file for my whole lbrary
Create one Bibtex file per collection
Create one Bibtex file per dooument
:fUsers fUser Documents

Path: Browse...

Citation Keys

Citation keys for documents are automatically generated in the format [Authar'fear]. To
'Citation Key' field on the Document Detalls tab

edit citation keys manualy, ensble the

oK Cancel

“Citation Key” field under Options
(Document Details tab). Then you can
your library.

You may enable BibTeX support here:

Tools==» Options == Bibtex Tab

edit citation keys under the Document Details tab in

12




4. Sharing Documents and References

How to Create a Group

Groups are a simple way for you to collaborate with your "V;,“’;mmmm
colleagues and share a collection of documents. Any member & Recently Added
of a group may upload documents to it. You can create a 2 v pubications
group by clicking on “Create Group” in the left hand pane. Unsorted y
Create Folder...
Groups

Create Group... b

Trash
m All Deleted Documents

Once you have clicked “Create Group”, a dialog asking you to enter details of your group will
appear.

Group name

Group description

Private
Privacy settings i Share references + files
@ Private

Mot wizible to the public; great for private research projects

Public
. Share references only
_ Invite-only
Publichy visible, but you decide whe contributes; great for public reading lists or curating
your lab's research output
_ Open
Publicly visible, everyone can contribute; great for open discussion groups arcund any
subject

Add additional info (e.g. tags, disciplines

[Create Group] ICanceII

1. Group name allows you to specify a name for your group.
2. Group description allows you to enter details about the group.

3. The section Privacy settings allows you to choose the type of group you want to create
(see below).

4. To add Tags, or to assign a research discipline to your group (by default, this is your
own discipline) click on Add additional info.

13



5. Click on Create Group to finish.

Note: You can review these settings later by clicking on “Edit settings”.

There are three types of groups:

1. Private Groups — These are invite-only groups whose content will only be visible to
members of the group. These groups are great for private research projects.

2. Public Invite-only Groups — These are groups which are visible to anyone, but only
members can contribute to them.These groups are great for public reading lists or
curating your lab’s research output.

3. Public Open Groups — These are groups anyone may join and contribute to. They are
designed for open discussion groups around any subject.

Adding members and documents
Once you have created your group, you can add members and documents to it.

1. To Invite Members to the group go to the Members tab.

2. You can either add people that are already your contacts on Mendeley by clicking on
“Add”, or you can invite people to join you on Mendeley by clicking on “Invite”.

ACME research group, owned by you Edit Settings

| Qverview | Documents | Members |

Invite people to join this group

Add % Invite

Your Mendeley contacts Collaborators via e-miail

3. You can view the documents of a group by going to the Documents tab. To Add
Documents, go to the group and click on “Add documents” in the top bar. Alternatively,
you can simply drag and drop documents to the group (either from your Mendeley
folders, or from anywhere else on your computer).

My I__ibrar\,r =] All Documents | Edit Settings |
=1 All Documents = - -
(& Recently Added * @ [ Authors Title Year PublishedI Added
Favorites o | The Mendeley Support Team Getting Started with Mendeley 2010 |Mendeley | 2:34pm

8 My Publications

Unsorted
Create Folder...

Desktop

Groups
] ACME research group
Create Group... 5 o | = | The Mendeley Support Team Getfing Started withMendeley ~ |2010 |Mendeley | 2:34pm

Trash
i Al Deleted Documents
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4. To download the PDFs that other group members attach to a group, go to Edit Settings
and tick “Download attached files to group”.
Note: the attached PDF files can only be shared in Private Groups, not in Public Groups.

5. To upload your group with all its settings to Mendeley Web, hit the Sync Library button.

Using Groups
The overview tab shows a summary of what has happened in your Group. You can see
updates on who has joined, who said what, and which papers have been added by whom.

You can also post status updates by entering your update into the box at the top of the
overview section.

Additionally, you can post comments and discuss your research. Just click on “comment”
and start a discussion on any given topic.

Mendeley Data Mining, owned by See Wah Chena Edit Settings

Overview | Documents (1) I Members

o

Mendeley Data Mining
T % Rosario Garcia de Zufiiga Canivell has left Mendeley Data Mining
e

Share

2ath September - comment - like

Mendeley Data Mining hide
% Colm McMullan and Benjamin A'lLee have joined Mendeley Data Mining

24th September - comment - like

1 Robert Knight added a document to this group
% 4+ Benchmarking Cloud Sering Systems with YCSB
18th September - like

Sebastian Arcq If you like this paper, you should also check out
"Benchmarking Tape Systems Performance” by Johnson / Miller

(1998)
less than 1 minute ago - delete
i
Mendeley Data Mining
% lan Mulvany has joined Mendeley Data Mining
&th September - comment
= You like this.

With Mendeley Groups you can collaborate, discuss, and discover new research together
with your colleagues. Create your own Mendeley Group today!
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5. Support

If you would like to request a feature or
report a bug in Mendeley, please visit

http://feedback.mendeley.com

or send an e-mail to

support@mendeley.com
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